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Abstract

In this study, we propose a Kernel-PCA model designed to capture structure-

function relationships in a protein. This model also enables ranking of reaction co-

ordinates according to their impact on protein properties. By leveraging machine

learning techniques, including Kernel and principal component analysis (PCA), our

model uncovers meaningful patterns in high-dimensional protein data obtained from

molecular dynamics (MD) simulations. The effectiveness of our model in accurately

identifying reaction coordinates has been demonstrated through its application to a G

protein-coupled receptor. Furthermore, this model utilizes a network-based approach

to uncover correlations in the dynamic behavior of residues associated with a specific

protein property. These findings underscore the potential of our model as a powerful

tool for protein structure-function analysis and visualization.
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Introduction

Proteins serve as fundamental components of living organisms.1–3 The three-dimensional

atomic arrangement determines structure, which in turn dictates their function. They are

dynamic entities that undergo conformational changes in response to various stimuli or in-

teractions with other molecules. It often leads to biological functions such as substance

release or enzymatic activity.4–6 Since structural changes directly influence biological func-

tion, deciphering structure-function relationships in proteins has long been a central pursuit

in molecular biology. This endeavor is crucial for understanding the molecular mechanisms

behind essential biological functions and diseases.

To achieve this understanding, extensive structural data is required. Experimental biol-

ogy methods typically provide limited structural data for proteins, usually only their stable

conformations, such as folded and unfolded states. On the other hand, molecular dynamics

(MD) simulations7,8 have the capability to generate thousands of diverse protein structures,

covering all possible states. Determining structure-function relationships using MD simula-

tion trajectories is also challenging due to their high dimensionality in space and sequential

time dependence. A promising solution to this challenge is the efficient data reduction

achieved through optimal protein representation. Protein representation refers to the way

proteins are modeled and described in terms of their critical features.

This representation is capable of identifying functional sites, interaction networks, dy-

namic behavior, and conformational changes in biological processes. In the field of drug

discovery,9–11 precise protein representation facilitates the discovery of potential drug tar-

gets and predicting the outcomes of molecular interactions. The representation is also vital in

protein engineering,12–14 where the design of novel proteins with desired functions relies on a

deep understanding of their structure-function relationships. In addition, the representation

will aid in modeling and simulation of complex protein systems.15 Such needs underscore the

importance of developing a representation that captures both static and dynamic features

determining protein properties. Moreover, it should effectively present the maximum vari-

2



ations in protein dynamics to minimize the data required for exploring structure-function

relationships. In this study, we introduce a model aimed at creating such a representation

while addressing critical questions, including the following: Is this model generalizable to all

proteins with different sequences and structures, when utilizing raw atomic coordinates? Is

it feasible to use only a subset of atoms to have a reduced representation? How could we

reveal the reaction coordinates using this representation? Is the model capable of identify-

ing the extent of contribution of individual residues to the overall protein properties?. To

answer these questions, we took advantage of machine learning (ML) methods, as they offer

computational tools and methodologies essential to dealing with high-dimensional protein

data.16–26

The two well-known techniques for feature extraction and dimensionality reduction are

Kernels27,28 and Principal Component Analysis (PCA),29,30 respectively. Kernels offer a

flexible framework for projecting datasets into higher-dimensional spaces. This enables the

transformation of protein data into feature map spaces that enhance learning. PCA is

a widely used method to reduce the dimensionality of data while preserving its essential

features. It is a linear technique that captures the directions (principle components) in

which the data vary the most. By integrating these two methods, we developed a model

that effectively analyzes protein structure-function relationships using MD trajectories and

provides meaningful representation for it.

Method

Our analysis begins with the preparation of the protein trajectories, as outlined in detail

in Supporting Information Section 1. Figure.1 illustrates the framework where raw atomic

coordinates serve as input for a Kernel model (Section I). The Kernel outputs are then

processed by PCA29,30 to extract the essential features. Later, the optimum representation is

selected via a defined Correlation ratio (Section II). Ultimately, this representation introduces
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Figure 1: Overview of Kernel-PCA model. Trajectories are initially prepared to provide
atomic coordinates as input for a Kernel model (K(λ1, λ2, λ3)). It is followed by PCA to
generate 2D representations for Kernel outputs. Finally, a defined Correlation ratio (Cr)
selects the optimal representation. This representation identifies and ranks reaction coordi-
nates based on their significance to the protein property while also uncovering correlations
among them.

reaction coordinates and highlights their extent of correlations with protein properties in

sequential order (Section III).

I. Kernel Design for Effective Representation

Why is a Kernel model necessary? Initially, we opted to use PCA29,30 on raw data due to its

ability to effectively identify principal components. These components are linear combina-

tions of original features achieved by projecting high-dimensional data onto a 2D subspace.

This subspace allows efficient visualization and analysis. However, PCA alone may face

challenges in extracting the intricate relationships within atom dynamics and their correla-

tions to overall protein properties when utilizing the raw coordination of atoms. This can be

attributed to several factors, including the high dimensionality of the data, which can lead

to computational costs and overfitting. Moreover, some raw coordinate data may have less
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crucial structural information, making it challenging for PCA to obtain maximum variations

effectively. Additionally, the presence of potential noises in the raw coordinates can fur-

ther hinder the performance of PCA. Furthermore, PCA is a linear model, whereas complex

coordinate data may exhibit nonlinear relationships. These challenges become particularly

amplified when our goal is to generate a representation in which PC1 predominantly captures

reaction coordinates and exhibits a strong relationship (roughly linear) with protein proper-

ties (Figure 2 b,d). This choice of representation is motivated by its ability to significantly

improve the identification of reaction coordinates. To address these challenges, we initially

developed a Kernel model.27,28

In our previous work,23 we demonstrated that the angles formed between atoms within

individual residues are particularly valuable for identifying switch residues, which exhibit

transitions between angular states correlated with protein function. Building on this foun-

dation, we developed an angular Kernel model that utilizes atomic coordinates to capture

conformational changes in proteins. We aimed to transform these data into a feature map

space to uncover conformation-function relationships. Later, the PCA effectively reduces di-

mensionality of the transformed space to 2D while retaining crucial information. The Kernel

model is defined as follows:

Kernel = λ1

(
cos

(x
r

))2

+ λ2

(
cos

(y
r

))2

+ λ3

(
sin

(z
r

))2

Where (x, y, z) represent the coordinates of individual atoms and (λ1, λ2, λ3) are hyperpa-

rameters. We established two constraints to limit the possibilities for hyperparameters and

narrow the search space. We ensured that each λi fell within the range [0, 1] and sum of

coefficients equaled to 1. In this study, we selected five values for λi as [0, 0.25, 0.5, 0.75, 1],

resulting in 15 combinations for (λ1, λ2, λ3) that confirm the summation equals 1.

It is important to note that studies have shown that the Kernel model enhances PCA perfor-

mance compared to relying solely on x, y, or z coordinates (Supporting Information Section
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d)c)

b)a)

Figure 2: Kernel-PCA representations of the NTL9 protein (a, b) and β2 adrenergic receptor
(c, d) corresponding to the lowest (a, c) and highest (b, d) Cr values. For the NTL9 protein:
(a) K(0, 1, 0) with Cr = 0.05, (b) K(0.5,0.5,0) with Cr = 0.15. For the β2 adrenergic receptor
c) K(0,1,0) with Cr = 0.03, d) K(0.75,0,0.25) with Cr = 0.13.

2). Figure.2 illustrates the impact of λi values in representations of NTL9 protein and β2

adrenergic receptor. For both cases, K(0,1,0) generates representations where neither PC1

nor PC2 exhibit specific correlation with the proteins properties (Figure.2a,c), whereas this

correlation is notably stronger with PC1 alone for K(0.5,0.5,0) and K(0.75,0,0.25) in the

NTL9 protein and β2 adrenergic receptor, respectively (Figure.2b,d). After determining the

optimal representation, we will elaborate on how to identify reaction coordinates using this

correlation between protein properties and PC1.

II. Evaluation of Representations Using Correlation Ratio

Among different combinations of λi values, one of them yields a representation that provides

the highest correlation between PC1 and protein properties. To automate the identification

of that one, we have established a metric for evaluating the Kernel’s performance based

on the correlation between PC1 and protein property. We first divide the PC1 space into

equal sections and calculate the average value of protein property in each section. We then

fit the best linear curve on the average values to find its slope (S) and the coefficient of
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determination (R2). In addition, we measured average of total variances of the protein

property within individual sections (V ). The Correlation ratio (Cr) is defined as follows:

Cr =
S ×R2

V 0.5

Where the highest Cr introduces the optimal representation with the strongest correlation

between protein properties and PC1. We assessed the impact of fifteen combinations of λ1,

λ2, and λ3 on Correlation ratios for Protein B, NTL9, Trp-Cage, and Chignolin. For details,

see Supporting Information Section 3.

Generating the optimal representation involved using all atomic coordinates within each

structure across thousands of trajectories. However, this approach will lead to high compu-

tational costs for large proteins. We experimented with using only one single type of atom

to develop a reduced representation. Initially, we considered individual atom types (such as

O, N , C, CA, etc.) and used each one’s coordinates for the Kernel-PCA model. Ultimately,

CB atoms exhibit the highest Cr value compared to other atoms. We observed that in large

proteins like β2 adrenergic receptor, using only CB atoms yields a higher Cr value compared

to using all atom types. This improvement may stem from filtering out noise, specifically

less important atomic information, from the input data.

To evaluate the effectiveness of CB representation versus all-atoms representation, we

defined RCB,T as the ratio of Cr for only CB atoms to Cr for total atoms. RCB,T value for β2

adrenergic receptor is 111.27%. For Protein B, NTL9, Trp-Cage, and Chignolin RCB,T values

are 99.64%, 89.23% ,93.01% and 87.84%, respectively. RCB,T values indicate that both using

all atoms and using only CB atoms yield mostly similar results for representation as well as

reaction coordinates. This approach led to a significant reduction in the feature space. For

example, in the case of the β2 adrenergic receptor, it decreased from 2175 (total atoms) to

260 (CB atoms) in a single structure. This reduction simplifies the model complexity, im-

proves computational efficiency, and focuses on more relevant features, potentially enhancing
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Kernel-PCA model performance.

III. Reaction Coordinate Identification

The aim of generating the optimum representation is to obtain the ranked reaction coordi-

nates. These coordinates serve as essential variables that distill the complex protein system

into essential variables that govern the protein’s function and biochemical processes. In this

study, the ranked reaction coordinates refer to the structural features contributing to the pro-

tein’s properties arranged according to their level of association. For the reaction coordinate

analysis, we focused on dynamics of individual amino acids in proteins. Since the dynamic

of α-carbon atom (CA) is sufficient to learn dynamic of entire amino acid,31 we measured

theta angles (arccos(z/r)) of the atom in every single residue over proteins. Each residue’s

theta angles were then projected onto the optimum representation for Cr calculation. Since

the highest Cr value for the protein property identified the optimal representation, the Cr

values of individual features over this representation effectively measure their contribution

to the property. As a result, we ranked the theta angles (reaction coordinates) based on

their Cr values. The top-ranked ones reflect the most dominant modes of motion at residue

level driving the protein’s property.

Dataset and MD Simulation

To assess the effectiveness and generalizability of our model, we benchmarked it using one

large protein and four small proteins. For the large one, we selected the β2 adrenergic

receptor, which consists of seven transmembrane helices (PDB: 2RH1). The original MD

simulation dataset32 was performed with the partial inverse agonist carazolol. The receptor

is embedded within a POPC lipid bilayer and solvated with TIP3P water molecules.33 The

simulations were executed in parallel on Google’s Exacycle platform34 and performed using

the Gromacs 4.5.3 MD package.35 Using these simulations, we can explore the activation pro-
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cess correlated with conformational changes in the receptor. For this protein, we randomly

sampled 10,000 structures within 5000 MD simulations.

For the small proteins, we used all-atom MD simulation trajectories for Protein B (PDB:

1PRB), NTL9 (PDB: 2HBA), Trp-Cage (PDB: 2JOF), and Chignolin (PDB: 5AWL).36–38

These simulations investigated the folding process in these proteins with diverse structures,

ranging in length from 10 to 47 amino acids. Protein B and Trp-Cage contain α helices,

while Chignolin stands out as a purely β-sheet protein and NTL9 displays mixed αβ struc-

tures. To generate the original dataset, MD simulations were initiated from random coil

conformations for each protein. They involved solvating all initial structures in cubic boxes,

ionizing them according to Lindorff-Larsen et al38 protocol, and employing ACEMD39 on

the GPUGRID.net network.40 The CHARMM22*41 force field and TIP3P water model33

were utilized at a temperature of 350K. For these proteins, we randomly sampled 10,000

structures from the original MD simulation trajectories.

Results

We aim to find optimum representations and capture the top-ranked reaction coordinates.

The diverse set of proteins, varying in size and structure with different properties allows us

to assess the generalizability of our model.

Case 1: Reaction Coordinates in β2 Adrenergic Receptor

G protein-coupled receptors (GPCRs) are a diverse group of cell surface receptors that un-

dergo conformational changes while interacting with ligands.42–44 Due to ligand binding,

GPCRs become activated and trigger intracellular signaling cascades, leading to various

physiological processes within the body.45–47 GPCRs consist of seven transmembrane helices

(TMs), among which the key conformational change during receptor activation primarily in-

volves the movement of transmembrane helix six (TM6).48,49 We analyzed structure-function
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Figure 3: Identification of reaction coordinates in β2AR using Kernel-PCA model. a) The
known reaction coordinates in β2AR are the intracellular parts of TM6 during the transition
from inactive to active state b) H3-H6 distances mapped onto the representation. c) amino
acid types located in where essential conformational changes occur during activation pro-
cess. d) top ten PC1 reaction coordinates, indicating dynamics of residues with the highest
contribution to activation states of the receptor. e) dynamic motion of A2716.33 projected
onto the PC representation.

relationship in β2 adrenergic receptor (β2AR).50,51 Figure.3a depicts the motion of TM6 be-

tween the inactive (blue: PDB 2RH1)52 and active (red: PDB 3P0G)53 structures of β2AR.

Typically, this conformational change is identified by measuring the contact distance between

TM6 and TM3.32 In this study, we measured the Cα contact distance between R1313.50-

L2726.34 residues in the receptor (denoted H3-H6 distance). Figure.3a also highlights H3-H6

distance increases from 8.4 Å to 14.1 Å in the transitions from inactive to active states. Given

the size of this receptor, we utilized only the CB atoms when generating representations (see

Section II). Due to the strong correlation between H3-H6 distances and activation states, we

established the optimal representation based on these distances. Figure.3b illustrates that

10



the chosen representation offers a strong correlation of receptor activation with PC1. There-

fore, we can analyze reaction coordinates within this representation, as discussed in Section

III. Figure 3c displays the top ten reaction coordinates in the receptor’s conformation that

are marked with colors, correspond to those listed in the table. Notably, all of them are

located at the intracellular part of TM6, where the receptor undergoes the most significant

motion during the activation process. This attests to the strength of our model in capturing

the essential structural features correlated to the protein’s property.

Figure.3d demonstrates the dynamic motion of A2716.33, as the first-ranked reaction

coordinate, mapped on the selected representation. Comparing it with Figure.3b, we observe

the theta angle in A2716.33 residue decreases when the protein becomes activated. Such

relationships can be identified by comparing pattern of distribution of each feature across

the representation with its corresponding pattern in the property. For further investigation,

the representations of reaction coordinates listed in Figure.3c are illustrated in Supporting

Information Section 4, Figure.S4.

Case 2: Reaction Coordinates in Protein B, NTL9, Trp-Cage, and

Chignolin

We assessed the folding states of Protein B (PDB: 1PRB), NTL9 (PDB: 2HBA), Trp-Cage

(PDB: 2JOF), and Chignolin (PDB: 5AWL) proteins by measuring the Root Mean Squared

Displacement (RMSD)54 relative to their non-folded reference structures (see Supporting

Information Section 1). For these proteins, Figure.S4 displays normalized Cr values plotted

against λi values, illustrating how different combinations of λi affect the Cr value. Moreover,

Table.S1 lists the λi values corresponding to the highest and lowest Cr values.

For the small proteins, Figure.4 depicts the optimum representations generated using all

atoms as well as only the CB atoms, colored by RMSDs values. The figures are followed

by corresponding fitted lines that maximize Cr values. Table 1 lists the top three reaction

coordinates in each protein, introducing the key residues correlated with folding states.
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Table 1: The top three most significant reaction coordinates in Protein B, NTL9, Trp-Cage,
and Chignolin, introducing the motion dynamics of residues with the highest contribution
to the overall RMSD.

Protein First-ranked 
residue

Second-ranked 
residue

Third-ranked 
residue

Protein B N35 E33 V34
NTL9 L6 K7 F5

Trp-Cage Y4 P19 A3
Chignolin Y2 W9 P4

a)

c)

e)

g)

Protein B

NTL9

Trp-Cage

Chignolin

b)

d)

f)

h)

Protein B

NTL9

Trp-Cage

Chignolin

All atoms

All atoms

All atoms

All atoms CB atoms

CB atoms

CB atoms

CB atoms

Figure 4: RMSDs projected onto the optimal representation, illustrating the maximum
Correlation ratio achieved using all atoms for (a) Protein B, (c) NTL9, (e) Trp-Cage, and (g)
Chignolin. Panels (b), (d), (f), and (h) show their corresponding representations generated
using only the CB atoms.
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It is obvious that even though the property is common among four proteins, the top-ranked

residues are recognized in different regions of each protein, which offers the possibility that the

folding mechanism may vary across these proteins. More studies are required to understand

the role of N35, L6, Y4, and Y2 as the first-ranked reaction coordinates in Protein B, NTL9,

Trp-Cage, and Chignolin, respectively, in their folding mechanisms. Extending this list to

include all residues as the ranked reaction coordinates allows us to analyze the internal

interactions of each residue, which demonstrate their collective impact in harmony.

Network-Based Insights into Reaction Coordinate Re-

lationships Linked to Protein Property

We delved deeper to establish connections among dynamical behaviors of reaction coordi-

nates linked to protein property (Figure 5). Our findings reveal that pairs of top-ranked

reaction coordinates form a harmonious linear and diagonal pattern when strongly associ-

ated with protein property. For example, in β2AR, theta angles in residues A2716.33 and

L2726.34 decrease simultaneously as the receptor becomes activated (Figure 5a). A similar

pattern is observed in the L6 and K7 residues in NTL9 protein during the folding process,

where both angles decrease as the protein folds. See Supporting Information Section 5 for

correlation between the top-ranked reaction coordinates in Protein B, Trp-Cage, and Chig-

nolin proteins. Exploring such relationships across all residues provides insights into how

a particular interaction influences protein dynamics and function. This network-based ap-

proach can guide targeted drug design and therapeutic interventions by identifying crucial

interaction sites and their impact on protein behavior.
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L272
A271
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Figure 5: Strong correlation between the top two residues associated with the protein prop-
erty. a) relationship between A2716.33 and L2726.34 residues in the inactive (blue), interme-
diate (green), and active (red) states of β2AR. b) interaction between L6 and K7 residues
in the unfolded (blue), intermediate (green), and folded (red) states in NTL9 protein.

Conclusion

In this study, we introduced a Kernel-PCA model for efficient protein representation, aim-

ing to elucidate structure-function relationships by identifying reaction coordinates. These

reaction coordinates are then ranked on the basis of their degree of contribution to the pro-

tein property. The flexibility of the representation, along with tunable hyperparameters,

ensures applicability to various protein dynamics obtained through MD simulations. We

initially evaluated the efficacy of our model by applying it to the β2 adrenergic receptor, a G

protein-coupled receptor with a known structure-activation relationship. Subsequently, we

applied the model to Protein B, NTL9, Trp-Cage, and Chignolin with unknown relationships

between structural features and folding processes. Using this model, we can also establish

14



interconnections among the dynamics of all residues linked to the protein property through

a network-based approach. This method provides a robust tool for understanding complex

biological systems and advancing biotechnology applications.

Data and software availability

The necessary information containing the codes and data for downstream tasks used in this

study is available here: https://github.com/pmollaei/ProtKernel

Supporting Information

The Supporting Information includes data preprocessing, protein representation using atomic

coordinates, Correlation ratios correspond to K(λ1, λ2, λ3), top reaction coordinates in β2

Adrenergic receptor, and relationships between top reaction coordinates in Protein B, Trp-

Cage, and Chignolin proteins.
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1: Data Preprocessing

I. Reference protein structure:

To simulate protein dynamics, water and/or ions may be added to the protein’s environment.

To isolate only the protein structure, the surrounding environment must be purified. For

the unfolded structure of small proteins, a chain of residues can also be constructed using

molecular visualization tools such as Visual Molecular Dynamics (VMD).? In our study,

we built protein B, NTL9, Trp-Cage and Chignolin through VMD and chose the purified

inactive structure of the β2 adrenergic receptor (PDB 2RH1)? as the reference structures.

To build the protein structure, follow these steps:

1. From components of a simulation (Figure S1a), select only the protein sequence (Figure
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Figure S1: (a) Original protein structure with additional elements from MD simulations, (b)
isolated protein structure after removing extra elements, and (c) aligned trajectory structures
with respect to the oriented reference protein.

S1b).

2. Build the reference protein structure using VMD (Main →Extensions →Modeling

→Molefacture →Build →Protein Builder →Add the sequence from part 1→Select

Straight →Build)

3. Save the PDB file of the reference protein. Later, you will align trajectory structures

to this one (Figure S1c).

4. (Optional): Open the PDB file in text format. If the order of atoms in the generated

PDB file does not match that of the trajectories, or if the residue indices are not sequen-

tially ordered (e.g., the N atom of residue #2 is located among the atoms of residue

#1), open the PDB file in PyMOL? and save it. Go to PyMOL →File →Export

Molecule (choose pdb format). Later, repeat this process for the trajectories.

II. Optional: Draw a sphere at the origin and shift the geometric center of the

reference protein to it

1. Load the reference protein in VMD. Use the ”move to origin.tcl” command (see GitHub)

in the TKConsole or specify it in the VMD startup command.
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III. Align principal axes of the reference protein with the x, y and z axes.

1. Download orient.tar.gz (here) and la101psx.tar.gz (here). The latter is a linear algebra

package by Hume Integration Software; more information can be found on this website:

http://www.hume.com/la/.

2. Unpack and load the packages and orient the protein using the ”alignment package.tcl”

(see GitHub)

3. Save the oriented reference protein.

IV. Prepare simulation trajectories

1. If the simulation trajectories contain extra elements, save only the essential protein

residues using the ”Selected atoms” section in VMD (for example, resid 2 to 9). Ensure

that the saved residues are compatible with the reference protein.

V. Align simulation trajectories to the reference protein

1. Load both the reference protein and the simulation trajectories into VMD. Ensure that

both files display the same number of atoms on the VMD main screen.

2. Align the entire simulation trajectory with the reference protein. Extensions →Analysis

→RMSD Trajectory Tools. Choose ”Top” for the ”reference mol” (ensure that the ’T’

on the VMD main screen is associated with the reference protein) and select ”Back-

bone” for the ”Selection Modifiers”.

3. Save the aligned simulation trajectories. They will be used as input for the Kernel

model.
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X, Cr = 0.0001 

K(0.5,0.25, 0.25),
Cr = 0.1215 

Y, Cr = 0.0025 

Z, Cr = 0.1139 

a) b)

c) d)

Figure S2: Protein representations using raw atomic coordinates: (a) x, (b) y, and (c) z
in the Trp-Cage protein (PDB: 2JOF). (d) The optimal representation obtained using the
Kernel-PCA model.

2: Protein Representation Using Atomic Coordinates

The preprocessed trajectories using only x, y and z coordinates of atoms may or may not

yield an appropriate representation associated with the protein property, depending on the

dynamic complexity of the protein. Figures S2 illustrate the RMSD projected onto the

optimal representations generated solely from the x (a), y (b), and z (c) coordinates of

atoms in the Trp-Cage protein (PDB: 2JOF). This analysis shows that, in terms of the

Correlation ratio, the z-coordinate of atoms provides a better representation compared to

the x and y coordinates. However, Figure S2d demonstrates that applying Kernel-PCA

results in a representation with a higher Correlation ratio, offering a stronger association

with RMSD. Thus, to achieve a generalizable representation that effectively captures key

reaction coordinates that influence global properties, we utilized the Kernel-PCA model.
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Table S1: The λ1, λ2, λ3 values corresponding to the highest and lowest Correlation ratios.

Protein Best 
𝜆1, 𝜆2, 𝜆3

Worst 
𝜆1, 𝜆2, 𝜆3

Protein B (0.5,	0.5,	0) (0,	1.0,	0)

NTL9 (0.5,	0.5,	0) (0,	1.0,	0)

Trp-Cage (0.5,	0.25,	0.25) (1.0,	0,	0)

Chignolin (0.25,	0,	0.75) (1.0,	0,	0)

Figure S3: Normalized Correlation ratio obtained from different combinations of (λ1, λ2, λ3)
for Protein B, NTL9, Trp-Cage, and Chignolin.

3: Correlation Ratios Correspond to K(λ1, λ2, λ3)

Table S1 reports the best and worst (λ1, λ2, λ3) corresponding to the highest and lowest

Correlation ratio. FigureS3 represents normalized Correlation ratios vs (λ1, λ2, λ3) for

Protein B, NTL9, Trp-Cage, and Chignolin. Although a specific combination (λ1, λ2, λ3)

could provide the highest Correlation ratio for each protein, the combination (0.5, 0.5, 0),

highlighted on the figure, can generate the representation with a high Correlation ratio across

different proteins.
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Level of 
correlation

Residue 
name

Correlation 
ratio 

1st A2716.33 0.284
2nd L2726.34 0.283
3rd H2696.31 0.198
4th E2686.30 0.194
5th K2706.32 0.174
6th K2676.29 0.159
7th K2736.35 0.150
8th L2756.37 0.123
9th G2766.38 0.104
10th T2746.36 0.077

Figure S4: Top ten reaction coordinates of the β2 Adrenergic Receptor, with each coordinate
showing the dynamics of the theta angle in the CA atom of each residue, projected onto the
optimal representation.

4: Top Reaction Coordinates in β2 Adrenergic Receptor

FigureS4 illustrates the top ten reaction coordinates in β2AR, representing the theta angles

of the CA atoms in the residues most correlated to the receptor activation process. As

described in Figure 3, all the top ten residues are located in the intracellular part of TM6,

where significant conformational changes occur during the activation process. Comparison

of Figure S3 with Figure 3.b reveals a strong connection between dynamics of the top ten

residues, both among themselves and with the activation state of the receptor.

6



b) c)a)
Protein B

Trp-Cage Chignolin

Figure S5: Top two reaction coordinates for (a) Protein B, (b) Trp-Cage, and (c) Chignolin
proteins corresponding to the theta angles of CA atoms in the top two amino acids correlated
with the folding state of each protein.

5: Relationships Between Top Reaction Coordinates in

Protein B, Trp-Cage, and Chignolin Proteins

FigureS5 shows the relationships between the top two reaction coordinates corresponding to

theta angles in two most associated residues with the folding states in protein B (a), Trp-

Cage (b), and Chignolin (c) proteins. This information provides insight into the correlation

between dynamics and conformations of these residues and their relationship with the overall

protein property and function.
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